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3 Software Agreement and Warranty

3.1 MUSAC Limited Software Licensing Agreement

PARTIES

1 MUSAC Limited (“the Licensor™)

2 You (“the Licensee”)

BACKGROUND

A The Licensor is the exclusive owner of the Software.

B The Licensor has agreed to grant a license to the Licensee to use the Software upon the
terms and conditions contained in the Software Licensing Agreement and any schedules
attached.

The Classic User Guide has the full Agreement and Warranty with MUSAC Ltd. See from your
most recent Classic MUSAC side bar, the Classic User Guide.

3.2 Software Warranty

This warranty covers any physical defect in the software distribution media.
MUSAC Ltd agrees to replace defective DVD/CDROMS by return post, without charge.

MUSAC Ltd is not responsible for problems caused by computer hardware or computer operating
systems.

All warranties or merchantability and fitness for a particular purpose are disclaimed and
excluded. MUSAC Ltd shall not in any case be liable for special, incidental, consequential,
indirect, or other similar damages even if MUSAC Ltd has been advised of the possibility of such
damages.

MUSAC Ltd is not responsible for any costs incurred as a result of lost profits or revenue, loss of
use of the software, loss of data, cost of recreating lost data, the cost of any substitute program,
claims by any other party other than the Licensee, or for other similar costs. MUSAC Ltd’s
aggregate liability arising from or relating to this Agreement or the software or the
documentation is limited to the license price paid by the Licensee.

The agents, distributors, and dealers of MUSAC Ltd software may not modify the Limited
Warranty nor make additional warranties binding on MUSAC Ltd.

MUSAC Ltd © 2015 Page 7 of 795
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Conventions used

Example

<Enter>
Ctrl

Alt+S
Click Next

Double-click
Type this

Select or
Highlight

MUSAC
SM, CM, AB6

Start, Enter

MUSAC

Description

Means ‘Press the Enter key’

Refers to the Control key, usually displayed as Ctrl on your keyboard

Press and hold the Alt key then press the ‘S’ key at the same time

Click on the screen button labelled Next

Press the left mouse button twice in rapid succession

You are required to type or locate exactly as it is written
Mono font also used to display files names and paths

Click at the end of text or to one side of an object and hold the left mouse
button down while dragging back across the text or object.

Refers to MUSAC Ltd existing product suite
Student Manager, ClassRoom Manager, Absences

Colour used to draw attention to text

Indicates compliance with Ministry of Education requirements

To indicate a school’'s MUSAC Administrator tasks

Information within this document may contain data from a school. Where this has occurred the

identities have been rearranged and any visual data has been purposely distorted.

MUSAC Website Registration

The purchase of MUSAC Ltd products includes all the necessary files. Future update files are
available for downloading by registered users of the MUSAC Ltd website (www.musac.co.nz). If
not already registered on our website, visit the MUSAC Ltd website to register for downloads and

support.

MUSAC Ltd © 2015
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SMS SOLUTIONS ACHIEVEMENT ENGINE MUSAC SEMINARS LATEST NEWS

The Achievement Engine for New Zealand schools
\

Stay Connected

with Teacher, Caregiver and

Student Web Portals

SMS Solutions Your Achievement Finance & Library Latest News

Engine Management n
Powerful products for all o . Ministry updates & resources
aspects of school management Use MUSAC to support driving simple tools to manage for educators
student Achievement school resources
o o o =]

Figure 1: MUSAC Website

User Registration
) Document Library

O Downloads Required field

@ Contact MUSAC Support Mame:
Username: *
Password: *

Confirm Password: *
Email Address: *

Confirm email Address: *

or Cancel

Figure 2: Registration Process

1 Complete all the basic details fields
2 Click Register

You will now receive an email with instructions on how to log on to the website.
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4 Installation

MUSAC Ltd highly recommends that initial training is conducted so staff can receive full benefit
from ClassRoom Manager’s extensive list of features. Please contact your local product specialist
for training — see www.musac.co.nz for North Island schools, or www.solutionsandservices.co.nz
if you're in the South Island.

MUSAC Ltd strongly advises that an authorised agent completes the installation process. This will
ensure that installation goes smoothly and efficiently. The MUSAC system files must be installed
on every computer using MUSAC Classic software. They hold the overhead utilities and
components which must form part of the system of each individual computer, and are part of
MUSAC Ltd’s mega installer.

If your file server is a ‘dedicated’ file server (ie. a computer used solely to manage the network
and not used for running programs and data entry) then you do not need to install the system
files on this machine.

It is also worth noting that the correct installation, configuration and maintenance of your
systems are essential to a well-functioning computing environment. For this reason, use of the
services of a MUSAC Ltd agent is recommended.

For further advice on your network, including infrastructure auditing, please contact MUSAC Ltd

Software Support on telephone 0800 600 159. if you have queries about whether or not a
specific hardware configuration is suitable for use with MUSAC Ltd software.

MUSAC Ltd © 2015 Page 10 of 795
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5 MUSAC Classic Installer

There are two sets of files involved in the MUSAC Classic installation process:

1 The MUSAC 32bit system files for all our software

2 The MUSAC program files

3 The Ministry’s Wrapper and .Net 3.5 SP1 Framework are also necessary for
interoperability with the Ministry’s server for NSN, ENROL, roll returns, etc and School-
links.

This installer installs or upgrades the core MUSAC Classic Products:
e Student Manager
e ClassRoom Manager
e Absences 6
e OneScreen
e Staff Manager
e Timetable (secondary and area schools only)

5.1 Installation Options

The installation of MUSAC Classic involves selecting the installation location (which the software
will detect if the product has previously been installed on this machine).

When installing updates, you MUST ensure no users are currently running ClassRoom Manager
(or other modules).

From CMAdmin > Other Utilities > School-links Export, filtered data can be exported to School-
links via the saved .csv file prepared.

The following products are still installed and managed separately:

e Financial Manager (Accounts/Assets)
e Library Manager

MUSAC Ltd © 2015 Page 11 of 795
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5.3 Typical Network Configuration

Most schools will install MUSAC software on a network, with pc’s in the school and ‘remote’
computers eg. a teacher’s laptop and a home machine.

1 CMAdministrator

CMAdministrator (or CMAdmin for short) is the administration module and must only be installed
on one machine—the fileserver. It must NOT be installed on remote machines.

The name of this program is cmadmin.exe

2 CMTeacher

CMTeacher (or CM for short) is the part of ClassRoom Manager which the classroom teacher
uses to enter information relating to their students, and to design and/or print documents
relating to that information.

If you are on a school-wide network then it need only be installed on the fileserver, as each
teacher can access it from there. The name of this program is cm.exe.

Note: Teacher’s laptop or home computer (ie. a remote computer) can be used. Files of data
can be accessed via a terminal server, please discuss with your MUSAC/IT administrator,
or MUSAC agent.

-

B3 School type
Flease zelect pour twpe of school.
Frimany, Contributing, Intermediate (v
Secondary i
Area or Composite i

Thiz information will be remembered and used ta
activate thoze areas within the package which apply
particularly ta pour schaoal.

This sereen will nat be
displayed in future. Proceed

Figure 3: CMAdmin school type

For this example we were installing for a secondary school. Click Secondary then Proceed.

- ~

CMAdmin

Please confirm that your school
is & Secondary schoal,

Figure 4: School type confirmation
Click Yes.

One or two other things may happen the very first time you run the ClassRoom Manager:

MUSAC Ltd © 2015 Page 13 of 795



ClassRoom Manager
MUSAC Classic 2015

1 A test that ensures several subdirectories (eg. /backup, /nzga, /natcols) have been
created. If they are not found then they are created
2 Tests are also carried out to ensure that the databases upon which the various packages

are based do, in fact, exist. If they are found to be missing then a copy of each database
is created

5.4 Unc Pathnames

A UNC pathname is a file address which refers to a computer by its network name, rather than
by a drive letter.

eg. \\IT12345\cm rather than M:\cm
MUSAC software prefers the use of drive letters. If the CM directory is submerged five
subdirectories deep then it's very useful to allocate a drive letter to the level above the CM

folder.

eg. \\IT12345\apps\MUSAC\cm can be known as M:\cm much like a nickname

MUSAC Ltd © 2015 Page 14 of 795
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6 ClassRoom Manager Overview

6.1 Purpose of ClassRoom Manager

In ClassRoom Manager you can design high-quality documents to enter student-centric data,
and print these documents. There are a range of national standards documents for the entry and
reporting of OTJs and related comments. Under NCEA are a number of documents summarising
and overviewing a student’s NCEA profile. For schools which do not have customised documents
set up by our agents for entering and analysing assessment data, a pre-configured solution is
provided. These are configured in CMAdmin > MUSAC Assessments and Profiles to make these
available in CM Teacher.

This software is a school-wide flexible administrative tool, potentially used by all teachers,
assisted by a co-ordinator who takes responsibility for the management of the module on a
school-wide basis. You are not restricted to data entries and reports which have been designed
for you. Documents and sections of the database can be configured to meet your own needs.
The database at the heart of the package is cm.mdb, similar to a large number of columns, and
one row for each student in the school. Each time data is recorded in a cell it is ‘date and
teacher’ stamped.

T unos
£ W
£ munjo
f Wmne
¢ Tmngo

Student 1

Student 2

Data

Student 3 call

Drata

Student 4
cell

Student 5

Student 6

Data
cell

Figure 5: CM is like spreadsheet

Documents are designed to show the data held in a cell for a generic student. When the
document is viewed then the data belonging to the current student is not only displayed on the
document but may also be entered or edited via the document.
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T e
7 mmje
£ momp)
Lz clel
S monp)

Student 1

Student 2

Data

Student 3 cell

Data

Student 4 / cell

Student 5 /

Student 6

I
h A document linked
i to data cells

Figure 6: A document linked to data cells

Some documents are designed for data entry, and others for reports to parents, the Principal or
to the Board of Trustees. Each is linked to data in cells.

Each teacher will wish to view just his or her students rather than the whole school, and select
from one or two documents rather than all those the school has designed. Dossiers provide this
person-centric marginalised view. A dossier is a selection of students and columns (a subset of
the database), and a document or two used to view/access the data.

Once set up, a teacher may have one or more dossiers.

T ey
7 umme
£ monjo )
g
et e

Student 1

Student 2

Data

Student 3 cell

Data
cell

Stdent / /

Student 6

Student 4 /

Figure 7: Several documents linked to data cells

You can also design graphs, tables, comment banks, markbooks, activities and pictures, which
may optionally be included in a dossier.

ClassRoom Manager is able to store scanned documents, video clips and other records of student

endeavour. It includes some complex result recording processes specific to the New Zealand
educational scene and some analysis processes relating to these.
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6.2 Components of ClassRoom Manager

This provides the administrative tools to manage various aspects of the package.

This is designed for use by the teacher. It allows the design of documents, tables and graphs
and the addition of new columns and comments. CM Teacher may also be used for the entry of
student information and for printing reports based on this information.

This program includes resource allocation and time-line management to help with all aspects of
curriculum delivery.

6.3 Basic Tasks for Administrator

The ClassRoom Manager administrator’s task is to manage the use of ClassRoom Manager within
and beyond the school and will involve:

Consultation with school planning groups to decide on the appearance of documents

The creation (or import) of columns which will hold the student data which the school
wishes to record

The design of the documents which link to these columns
The addition of staff members to the staff database

The creation and management of dossiers for teachers

A wide variety of other functions, for example:

e export and import of e-asTTle data

e creation of popup files

¢ management of group rights for teachers

e maintenance of comment banks for reports

e creation of markbooks

¢ management of student photos

e setup for National Standards reporting (see National Standards for details as well as
the latest on our website www.musac.co.nz. Documents can be added to dossiers if

you wish)

MUSAC Ltd © 2015 Page 17 of 795
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6.4 Basic Tasks for ClassRoom Manager Teacher

ClassRoom Manager enables your school to:

record student results, write report comments and document National Standards
print documents, print graphs

keep track of progress, keep track of activities

work at home

The basic processes have been designed to be simple to aid teachers to:

log in to CMTeacher

select the dossier with which to work

select the document or markbook with which to work
move to the required student

enter results or comments including National Standards requirements (see our website
www.musac.co.nz for latest developments, and section below for more details
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7 CMAdmin Menus

CMAdmin (ClassRoom Manager Administrator) consists of two (or three — secondaries have a
page for NZQA) screens of buttons, each of which provides access to a specific management
task.

The opening screen is the main menu screen.

Setting c :
things up for oy oy i Lhohy -CmmEN oy
o 8 mantmrnce | | Aok matenance | | o watenance | | “BF Bk | | Sp TSI
your own Maintenance
school
Bring data in | )
from other Wl ExternalData | | ) oo L
packages 6o Import e
Making
dossiers, 1 Teachersand | | ~9* Mergea
merging data || Their Dossiers | | 9 Dossier
and other
Other menu ) ) 2 Multi-school
T & e S Multi-school
screens * NZQA Utilities * Other Utilities Utilities

Figure 8: The main menu screen — secondary school version

The primary/intermediate school and secondary school versions are similar, and vary with the
inclusion of the bottom row button which provides access to the NZQA menu screen.

It has also sensed that the program is being operated in ‘multi-school’ mode. In this mode two
or more schools share the same databases and access is provided to utilities peculiar to that

situation via the ‘Multi-school’ button in the bottom row.

Click the ‘Other utilities’ button for a portion of the relevant menu shown below.
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N File View Help
=
=8 _CM Administrator Utilities
g
] National
g f’u’\\ Backup / — Wiho is Standards
= @3 Restore Data S5 Accessing CM Board Report
2
=
Y ) Transfer
' View Basic # A% Import and L |l » CEMdata
- Students FDF Setup Sl

) studentdata | | g oo o | | ¥ Export Lt s Import

. Specify t . Specify NZSS5C

4T Markbook W Marks Analysis| |9 1+ Activity W Activities Ehotogg;ph

Details Details S Impart rpetuons
Global Global teacher Progress ’

B - I : Ll . Adapt 95 asTTle and

| Document | & Dossier ol Tracking : L
E Management u Management *’ Management Analysis NZCER Utilities
fisel & View the Log 4% 5chooldinks S, Web Portal 35
E *’ NZQA Utiities % File d} Export Configuration w Eas
| |

Figure 9: The ‘Other utilities’ menu screen — secondary school version

7.1 Printing the NZSSSC Report from CMAdmMin

All school sports information can be maintained completely within the CMAdmin Activities area
and the NZSSSC Report can be printed directly from there. For current details on the Census,
see the NZSSSC website.

The following is specific to NZSSSC information - see Help file, Activities area of CMAdmin.

1 Click ‘Other Utilities’ from the main CMAdmin menu.
Create and Adjust
Activities

2 Click ‘Specify Activity Details’.

Printing Functions

H . . ) Copying Activities
3 Click ‘Create NZSSSC Report’. This will be used when the report is

required for the New Zealand Secondary School Sports Council.

Documents and
Dossiers

Create NZS55C Report
Setting up Sports activities and entering data: :

Click ‘Create and adjust activities’.
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- E._Speciﬁcationof_

Activity details l Activity schedule i Student columns i Student 'awards' i Attaching students ] Coaches/Managers etc i
Create and Adjust e
Current activity : Cycling User-defined details (add your own rows)
— _ Activitiesin:| 2015 [=] e [cyding I Item |Detai
Printing Functions . ! |
Group : | Sports team ]Z[ Abbreviation |Cyc (For column titles) |
Copying Activities Basketball Fivers ~ Category Sports team E| |
Basketball Inr U17 - |
Eanls Chil Year 2015 -
DOC[L;:IEUE g Central Zone Swimmir |
TS Cricket - Junior | |
- i - |Z| :
_Create MZ555C Report Dragon Boating ¥ 13 i |
Dragon Boating Year — feenbcontacid; |
E tri |
Fﬁ]ﬂ::s Iaﬂb Parent contact 2 B I
Get 2 Go Challenge :
Give it a go Challenge . ’Add row] ’Insert row ] ’Delehe row] ’Edlt headings
Gymnastics NZSSSC Details:
Hockey - 1st XI o
Hockey - 2nd XI NZSSSC Sport Bocce] E Activity notes
Hockey - U15 8 a-side » Curling [
Hockey 7 &8 Marist b Competition level Cyding - Mountain Bike |
Hockey ¥r 7838 = Cyding - Road =
Junior Athletics Cham Coach 1 Cydling - Track A

Coach 2

— Diving
Add a New Activity Dragon Boats
Manager 1 Equestrian
_Save Changes Fendng D

Manager 2 Football (outdoor)

Delete Selected Activity Offical 1

Add a New Category Official 2 E|

RIOBRCCIRNEIEIE

Figure 10: Activity Details tab

At the top of this screen includes the tab, ‘Coaches/Managers/etc’:

Clicking on this tab brings up the screen for entering relevant data for all the Coaches, Managers
and Officials involved in sports at your school:

Activity details | | | |  Coaches/Managers/etc |
Coach / Manager /[ Official Details
Current Coaches, Managers and Officials:
Family name OMale
First name ) Female
Address 1
(O Teaching staff
a2 () Non-teaching staff
Address 3 () Community member
Home phone O student
Work phone
Cell phone
Email
Other
Select an entry in the above list to edit
lAdd a Mew Coach / Manager [ Official ] a person's details
l Save Details ] l Delete Selected Entry from Database

Sports Data Entry Screen

Back on the Activity details tab, if you click ‘Sports team’ from the Group drop-down or
you click on any particular sports team the input fields are displayed:
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Activitesin:| 2012 [ | e

Group : |Z| Abbreviation

All groups

Activity group Category

Cultural group

Music group Year

nt

Teacher I.C.

NZ555C Details:
NZ5S5C Spart | v |
Competition level | w |
Coach 1 | v|
Coach 2 | w |
Manager 1 | v|
Manager 2 | W |
Offidal 1 | v
Offidal 2 | v

Figure 11: Sports Team input Fields

The NZSSSC Sport box contains a list of all sports (which is periodically updated) in the

NZSSSC Report. Select the correct sport for the team you are setting up.

Competition Level contains the three levels which are required for the NZSSSC Report:

NZ555C Details:
MZ555C Sport
Competition level
Coach 1

Coach 2

Manager 1
Manager 2

Offical 1

Offical 2

Competition level
Coach 1

Coach 2

Cross Country

Cyding - Road
Cyding - Track
Disability Sports
Diving

Dragon Boats
Equestrian

Fencing

Curling
Cyding - Mountain Bike o

5
B

[+
School Rep
Qutside Club Rep
Interform/House

N

Coaches, managers and officials contain the names you have entered in the database.
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Click ‘Create NZSSSC Report’ for the following screen:

Creation of Report for New Zealand Secondary School Sports Coundil
- - * School

Please DO NOT run this utility if Microsoft Excel is not installed on your computer,
Instead use the NZSS5C SportSCID program to generate the report.

Please make sure the following fields are filled in before you create the report. Where possible fields have been
pre-populated - please chedk they are correct, Student numbers are as at 1 March.

[JLeavers have been moved to a leavers' database

Mumber of Year 9-15 females Mumber of teaching staff 17
Mumber of Year 9-15 males Mumber of non-teaching Staff |
Total Mumber of Year 9-15 Students = 438 Total Mumber of Staff = 17

four name

Position w

Type of school L3

School decile rating 2

RSD [ S5C aligned with w

[ Generate NZS55C Report ]

Sports Council Creation of Report screen
Our software assumes Microsoft Excel is installed on your computer (required for the SportSCID

program); if not you may need to use SportSCID to generate the report.

The data required is similar to ‘School Information’ within the SportSCID program. The numbers
of Year 9-15 females and males and Total Number of Students have been pre-populated from
the SM database. All other fields must be filled in before generating the report. The number of
teachers cannot be 0.

The drop-down lists have been populated with the same entries as those in the SportSCID

program, ie:

Position:

Sportz DirectorHOD
Sportz Co-ordinator
$|:u:|rts Agsistant

Type of School:
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Area P
Independent Year 7-15 Coed
|ndependent v'ear 7-15 Female
Independent Year 7-15 Male

Independent Year 3-15 Coed
Independent v'ear 3-15 Female
Independent ear 3-15 Male

| Middle A

RSC/SSD aligned with:

Spaort Marthland ”
Spart Marth Harbaur

| Sport Waitakere

Sport Auckland

7 Countiez Manukau Sports Foundation
Sport Waikato

Sport Bay af Plenty

Spaort Eastland b

Click ‘Generate NZSSSC Report’ to produce the same spreadsheet as that produced by the
NZSSSC SportSCID program. However, instead of it being named yourschoolname.xls it will be
named nnnNNZSSSCyyyy-mm-dd.xls, where nnnn is your school Ministry of Education nhumber
and yyyy-mm-dd is the current date.

MUSAC Classic 2010 X

D The MZ555C Report has been created in the CM folder,
\“.r/ Please send the file C:\CM\21INZS55C2010-08-31.xls to NZSSSC when the final report has been completed.

Do you wish to preview it now

Mo

Figure 12: NZSSSC Report Confirmation

This spreadsheet will identify a single ‘School Sport Participant’ category differentiated by
gender. School Sport Participants are students who had MEANINGFUL ENGAGEMENT in each
sport in your school; who

e represented the school in that sport, OR

e took part in a sport provided in-school over a period of six weeks or more, OR

e played for a club arranged by the school as the school had no teams in that sport, OR

e took part in sport provided through the KIWISPORT initiative.

Therefore students who took part in “one off” in-school events such as school athletics,
swimming sports, or short term inter-form/house events are NOT included.
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The primary school version of the ‘Other Utilities’ menu screen, is very similar to the secondary

school version except that it has fewer buttons, as follows.

File View Help

CM Administrator Utilities

# % Backup f | Who is
%) Restore Data S Accessing CM
. Transfer Metwark:
View Basic - #9% Import and - )
' _ . 5Students e - Domain User
“’ Student data " Between Files - ErTi = Connector
Spedify Spedify NZ555C
- P Photograph
o 1= Markbook Tk Activity S Activities ) -
W Details ™ Details P mport TR
5 Global Global teacher Adapt
|~y Document L\ & Dossier / . © = asTTle Utilities
| " .
u Management il Management % Analysis Wa

Figure 13: The ‘Other utilities’ menu screen — primary school version

For secondary schools click ‘NZQA utilities’ from the main screen ‘Other utilities’ screen, and the

following menu screen is displayed.

File View Help

CM NZQA Wilities

) Manage Updating via
Ms.,atnagde Lén't & Achievement S Mew MNZQA ma 5 Stagdﬁrdt
anaards Standards Files preadsheets
Connect Specify
“a = Standards to “al & Markbook S Student Billing
L Subjects Details W
Printing FL  Global #% Submit Results| | ol 5 Imports from
=" Utlities D% Processes D tonNZQa ) hzQa
B NZQA Check | | (7)) Accesshizqa | | @ Students' E g Mtaém:r”t of
List A% \ebsite &) standards “GpJa Standards
o) Other Utiities

Figure 14: The ‘NZQA utilities’ menu screen
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The ‘Multi-school utilities’ menu, accessed from the main menu screen in the secondary school
version has one button other than the ‘return to main menu’, as shown.

File View Help

Multi-school Utilities

Identify
“o = Duplicated
el Leavers

L § J Close
(i) c

Figure 15: The ‘Multi-school utilities’ menu screen

The pull-down menu items are not used much as it is easier to click directly on the required
utilities rather than hunt through a pull-down menu. Consequently, the ‘File’ menu has one item:

View

Exit

Help

Figure 16: The ‘File’ menu

The software prefers that you use the large exit button at the bottom right of each menu screen.

The ‘View’ menu below, allows you to choose from four basic colour schemes. These are:

Basic grey, as shown in the illustrations
A rather pleasant whitish background

A pale blue background

A sort of brown coloured background

Help

Background shading »

Grey

First
T % Custom 2
P Custorn 3

Restrict to light graphics (for thin dient terminals)

Figure 17: The

‘View’ menu

In addition to these is the possibility to restrict the program to ‘light (or lite) graphics’. This
setting is designed to cause the screen to be drawn somewhat faster than the four ‘colour’
settings and this can be beneficial in terms of speed when operating the software via the thin

client.

Help

Figure 18: The ‘Help’ menu

Clicking on Help from the Help menu displays a message to choose ClassRoom Manager or the

NZQA User Guide.
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7.2 Where to from here?

MUSAC agents can help you plan what you need. They have been through this process with
hundreds of schools and can easily guide you along the most productive paths. Not only that, a
large number of the documents you will need have already been designed for other schools. The
‘MUSAC Assessments and Profiles’ button in CMAdmin provides documents and graphs for
analysis, bearing in mind that any documents modified MUST be carefully renamed to avoid
being over-written with subsequent updates.

If you are a primary school then your main aim may be to monitor students’ progress towards a
number of the school’s objectives using perhaps Curriculum Framework objectives, PAT tests,
your own Specific Learning Outcomes and National Standards. You might also wish to design
some sort of Cumulative Record document.

If you are a secondary school then you will probably want to design your term reports and
subject analyses.

The tasks of the administrator determines the path through the buttons. Firstly, set up the
columns to hold the data to record. When the module is first installed there are only ten student
data columns:

Family name

First names

Preferred name

Year

Horizontal class group (Class, Year or form etc)

Vertical group (Whanau, House, room etc)

Gender

Date of Birth

Status (Full time, Part time, Pre-enrolment, Leaver or Delete)
Ethnicity

© 0N O Ul WNDN P

A=Y
o

MUSAC has also designed several thousand other columns for you called the ‘National’ columns
as they will be the same for every school and data held in these columns can be exchanged
between schools. In addition to these you might want to design your own.

Once the columns are in place, add your students. In Student Manager they will already be
there waiting for a document via which they can reveal themselves. If you don’'t have Student
Manager then you’ll have to either import students separately or add them to the database
manually.

Documents are designed in CMTeacher, not in CMAdmin. So, for those who wish to take that
step, see the CMTeacher latter part of this document.

Add your staff members to the staff database, and to give them suitable rights to access the

various functions of CM, create dossiers for your teachers so that they see only their own
students and only columns relating to those students.
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Your teachers may want to take their dossiers home either on a pen drive (to use on their home
machine) or on their laptops. Ensure that the background school details from Student Manager
are correctly set up in CM. The teacher portal of Classic web portals is available, for more
information contact MUSAC Support on 0800 600 159.

Having covered the main menu buttons, to the ‘Other Utilities’ menu. The main one, particularly
for secondary schools, is the creation and management of markbooks. Some primary and
intermediate schools now use markbooks too. (Markbooks are like the teacher workbook, where
you have 100 columns to record your own details concerning your students, frequently based on
subjects. We’ll show you how to manage markbooks too.

Finally, all of the other functions and utilities you might need from time to time to ensure the
smooth functioning of CM.
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8 Columns

Some of the following buttons are dealt with here.

File View Help

Hrst MUSAC Install

1 i ®, School Details ot Assessments “a 1= Supplied
steps and Profiles Components
Setting
things up for Yohe  Group Yohe  Column Yoie  Popup File Tohe Coﬁ?ﬂanr:Ent Fohe Assessment
er:r (;wn Y Maintenance Y Maintenance % Maintenance Lo Maintenance ¥ Tool Selector
SCho0!

Figure 19: The ‘Column’ buttons

Remember: Some sections and processes may be considered of greater importance in the
scheme of CM than others. Those which you can afford to skip on a first reading will have a
small icon to indicate that you can return to them for fuller detail if required.

8.1 MUSAC Assessments and Profiles

Many schools have custom solutions created especially for them by our Agents, some schools do
not. To assist schools which do not have a selection of documents for entering and analysing
assessment data, ClassRoom Manager comes with an “out-of-the-box” solution. The MUSAC
Administrator ticks a box to have the first set of documents and menus available in ClassRoom
Manager. Any existing documents are also available in the same way. The initial set contains
PAT, e-asTTle, STAR and National Standards. For Secondary schools, Academic Mentoring, and
NZQA/NCEA tracking is also available. Further editions to this easy solution may be added.

To make the out-of-the-box solution available to teachers, also see 21.3 Pre-Selection of
dossiers, Documents and MUSAC Assessments and Profiles:

From the CMAdmin main menu click ‘MUSAC Assessments and Profiles’
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[ Install MUSAC Solution

MUSAC Preconfigured Assessments and Profiles

[ |Enable the preconfigured MUSAC Assessment and Profile document solution

Should you dedide to use the MUSAC pre-configured document solution, you need to be aware that the
installed documents and menus could be updated any time a new release is installed or a new document pack
isinstalled. Any customisation to these MUSAC documents will be overwritten. Your personal documents will
NOT be overwritten. However, if you choose to customise THESE MUSAC documents, please ensure that
they are saved as new documents with custom names. This will ensure that your customised documents are
not overwritten, MUSAC agents are experts in document customisation and are available to advise you.

- By default, the box is not ticked, and the preconfigured solution is not available.
- Once the checkbox is ticked, click >Update for the change to be effected.

[¥]Enable the preconfigured MUSAC Assessment and Profile document solution

Please read the note displayed below, and then cdlick >Update to complete the process.

Should you dedide to use the MUSAC pre-configured document solution, you need to be aware that the
installed documents and menus could be updated any time a new release is installed or a new document pack
is installed. Any customisation to these MUSAC documents will be overwritten. Your personal documents will
NOT be overwritten. However, if you choose to customise THESE MUSAC documents, please ensure that
they are saved as new documents with custom names. This will ensure that your customised documents are
not overwritten. MUSAC agents are experts in document customisation and are available to advise you.

If further clarification is required, please consult your MUSAC Agent, MUSAC Client
Support or the MUSAC web site. www.musac.co.nz

Update | | Close

The documents and menus are delivered as packs when version 12.9 or later of MUSAC Classic
is installed. Once the MUSAC Administrator has ‘ticked the box’, the next time ClassRoom
Manager is opened, the packs are un-packed and become available. This process may take a
few minutes, but it is a once only delay while the documents and menus are unpacked.
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Primary Schools:

[}
]
Asa Learming Goals
) s Nabonal Standards
rvlar Amsosement Main Menu
Aggregated Reportng
{3 Al Documents
STAR Testing | STAR Whole School
Enter data for STAR here STAR Data Entry ||_ Anahysi |
. ., ’
Progressive Achievement Testing (PA'
= Enter data for PAT here ®4) I PPAT Data Entry || PAT Analysis |
e-asTTle Data
This dats is imported from the e-asTTie website | e-asTTle Data Entry II #-asTTle Analysis |
National Standards and School Repons i P
Enter Final OTJs - End-of- Year Reports I OTJ“E:;“M | | Mw
Student Profile
#dd Document
Add Graph
M [smmn] 1 of 2 E1I— T FT
prev || Nea |[ ptanner || print [ Merge || Options |[ cube || adapt | [ <page |1/1[ page»

CM opens with this menu where all the additional documents are available.

To view any other documents that you may have, click on >All Documents on the left near the
top, and the panel on the left will be filled. Click on a document to view it as normal. Clicking
>Main Menu right at the bottom on the left displays the Main menu again.

Technical Detail:

- Updating the MUSAC Main Menu.dmt occurs automatically if a new menu.dmt — labelled
with the correct moe school type is unpacked from the component pack. ( e.g. OMUSAC Main
Menu.dmt becomes MUSAC Main Menu.dmt)

- The first time CM is opened after an installing the MUSAC Assessments and Profiles, the
new menu for your school type becomes the new MUSAC Main Menu for all the users in the
school.
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For Secondary Schools:

Main Menu
Assessments Profiles
| e-asTTle Data Entry | | e-asTTle Analysis | Student Profile Academic Mentoring - Goals
| PAT Data Entry | | PAT Analysis | NZQA Tracking
(Current Year)
[ wna | [ w2z | [ wis |
| STAR Data Entry | | STAR Analysis |
| NCEA Profile l | NCEA Historical Tracking I
| Entrance Tests (Y9) | | Midyis |
| OTI Data Entry (Yrs 7 - 8) | | Nat Stds (Yrs 7 - 8) |

il 10f 3 IR E_—_—_—__—_—_—|—|——ee
Irev Next |

CM opens with the menu above on screen. All the additional documents are available through
this menu.

To view any other documents that you may have, click on >All Documents on the left near the
top, and the panel on the left will be filled. Click on a document to view it as normal. Clicking
>Main Menu right at the bottom on the left reveals the Main menu again.

Your MoE school type determines the pack (eg. years 0-8 or secondary solution covering years
7-13).

8.2 An Overview of Columns

Each column has a number of properties which include:
e name
s type
e short description
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e long description

e up to five categories

e aconnection to a popup
e aformula

e keywords

The column name is displayed at the top of the column (when viewed as a spreadsheet).

Columns come in several types determined by where its data is stored in the database. Column
types include:

A number column can hold very small to very large numbers (For the experts, it can hold a
double-precision long)

A text column can hold many thousands of characters

For example a report comment where parts of the entry may be bold, italicised, or in a different
font etc

For example Date of birth, Date started school etc

Sometimes you select from a popup file (eg. Gender, Type). The column holds the pointer to the
selected popup entry.

Up to ten characters

A curriculum framework column holds up to six dates. The date ‘Begun’, the date ‘Achieved’, the
Date ‘Mastered’ — or whatever you have decided are your (up to) six degrees of achievement
towards Curriculum Framework objectives.

For example NZQA fees

These are the basic column types from which you must select when designing a column. There
are, in fact, several other ‘column types’ used in the internal working of CM and SM (Student
Manager). These include:

e Markbook - A markbook ‘column’ can hold 200 marksand eight report comments.

e NZQA standards

e Financial transactions
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e Pastoral transactions
e Register entries

Now import some columns.....and maybe other things as well.

8.3 Install Supplied Components

Click ‘Install Supplied Components’ for the following screen.

_ | [ Sanctart o

Import of new components from MUSAC

Install Standard
Columng fram MUSAC

Install Pop-ups
Supplied by MUSAC

Www.musac.co.nz

Install Multi Serve
Learning Outcomes

Figure 20: Install Supplied Components

To import columns click ’'Install Standard Columns from MUSAC’.

& Standard Imports.

Import of new columns from MUSAC

Please select the group of columns which you wish to import.
(Repeated importation causes no harm but does not achieve anything!)

Install Standard
Columns from MUSAC

Curriculum Framewark columns Item Previously Installed | Newly Installed
Install Pop-ups Curriculum Framewark Best Fit columns Category 1 0 0
Supplied by MUSAC Secondary School columns Category 2 5 a
- Reports Name Field

Install Multi Serve Internet connection columns Category 3 0 0
Learning Outcomes Secondary tracking columns Category + 0 0
Category 5 0 ]

Columns 0 a

Columns to import :

Careers Columns A Absence Summary Columns

NZQA Columns = Click on 'Proceed' to have columns processed.

Record of Achievement Columins

Did you accidentally install some columns? You

AsTTle test results {Term 1set) = can uninstall them by ticking this box and dicking O
AsTTle test results (Term 2 set) ‘proceed'. (any containing student data will be

AsTTle test results (Term 3 set) preserved.,)

AsTTle test results (Ver 3 Term 1set)

AsTTle test results (Ver 3 Term 2 set)
AsTTle test results {Lev 3 Term 3 set) Import any assodated

AsTTle test results (Lev 3 Term 4 set) documents O

AsTTle test results (Term 4 set) b Back

Figure 21: Import of secondary school columns

The top left window displays several categories of available columns. Those shown above are for
a secondary school. Select one of the categories and several subcategories of columns will be
displayed in the window below. From this window select those sets of columns which you wish to
import. You can select more than one subcategory at once. In the example select ‘Secondary
School columns’ in the first window and both ‘Absences Summary columns’ and ‘Secondary
School ESA Information Skills’ from the second window.
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On the right is a progress window which lists the number of column categories, some
information concerning your selection, the opportunity to remove accidentally installed columns
and a couple of buttons. The ability to uninstall columns is *REALLY USEFUL* for those who
accidentally install several thousand unrequired columns.

The equivalent pair of windows for a primary school is shown below.

Primary Schoal columnz

|ntermediate Schoal colurmng
Curriculumn Framework, columis
Curriculurn Framework, Best Fit calumng
Reparts Mame Figld

|ntemet connection columns

AzT Tle test results [Term 1 zef) ”~
AzT Tle test resultz [Tem 2 zet]

BzT Tle test resultz [Term 3 zef)

AzTTle test results [Tem 4 zet]

b arie Clay Age 5 to 6.5 Testing

barie Clay Age 5 to 6.5 Testing

Primary School Duncan 'wWord Reading

Primary School ESA Information Skill:

Mumeracy Years 0-6 Setz 1 and 2

Murneracy vears 0-6 Set 3

Mumeracy Years -6 Set 4

Prirary School PAT £, Pretoz and TOSCA, ol

Figure 22: Importing primary school columns

A full list of all available columns is provided in an appendix - The National Columns.

MUSAC also provides standard data entry screens (documents) for various sets of columns,
including each of the Curriculum Framework Learning Areas, level by level. If you wish to import
these, check the small box which offers this facility. As the columns are imported you will be
offered the chance to also import these standard documents. You may not wish to do so, either
wishing to design your own or obtain different versions from elsewhere (eg. our agents Edtech
have their own designs).

Once you have made your selection click the ‘Proceed’ button and your chosen standard columns
will be added to the database.

As mentioned already, full details of the National columns are provided in an appendix but they
include, for example:

e New Zealand Progress Achievement Test columns (PAT tests)
e Primary School Standard Testing columns

e Primary School reporting columns

e Secondary School Subject columns

e Record of Achievement columns

e Careers Information columns

e Various sets of Curriculum Framework columns
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At the end of the import process the result will be displayed. You may either exit at this point or
select another set of columns for installation.

From time to time MUSAC will update the sets of standard columns. Any matching columns will
be ignored and new columns will be added.

One of the possible types of columns is the popup column. This is a column which is linked to a
popup. An example of a pop-up is ‘Ethnicity’ where each student’s entry in the column is
selected from a popup of possibilities. In the case of ‘Gender’ there are two possibilities, in the
case of ‘Type’ there are five (Full time, Part time, Leaver, Pre-enrolment, Delete)

A reasonable number of predefined popups are included, also see maintenance of popups.
Some are optional, and you may import selected popups using this utility. Click

Install Pop-ups
Supplied by MUSAC

Import of pop-up files from MUSAC

Pop-up files consist of sets of possibilities (eg ethnicities) fro
student. From time to time MUSAC may distribute new sets 1

Flease select from any pop-up files Imported
shown below. (dick to select /

Burt Equivalent Age (Midpoint)

Early Childhood Education

Hobbies

Home language

PAT Listening Comprehension E.A.B.
PAT Reading Comp E.A.B.

PAT Reading Vocab E.A.B.

Reading Levels (MUSAC Central)
Reading Levels (Sol&Ser version)
Reading Levels (EdTech version 1)
Reading Levels (EdTech version 2)
Favourite Subjects

Type of part time work

Connect any ‘reading G